Note the following details of the code protection feature on Microchip devices:

- Microchip products meet the specification contained in their particular Microchip Data Sheet.
- Microchip believes that its family of products is one of the most secure families of its kind on the market today, when used in the intended manner and under normal conditions.
- There are dishonest and possibly illegal methods used to breach the code protection feature. All of these methods, to our knowledge, require using the Microchip products in a manner outside the operating specifications contained in Microchip’s Data Sheets. Most likely, the person doing so is engaged in theft of intellectual property.
- Microchip is willing to work with the customer who is concerned about the integrity of their code.
- Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their code. Code protection does not mean that we are guaranteeing the product as “unbreakable.”

Code protection is constantly evolving. We at Microchip are committed to continuously improving the code protection features of our products. Attempts to break Microchip’s code protection feature may be a violation of the Digital Millennium Copyright Act. If such acts allow unauthorized access to your software or other copyrighted work, you may have a right to sue for relief under that Act.

Information contained in this publication regarding device applications and the like is provided only for your convenience and may be superseded by updates. It is your responsibility to ensure that your application meets with your specifications. MICROCHIP MAKES NO REPRESENTATIONS OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY OR OTHERWISE, RELATED TO THE INFORMATION, INCLUDING BUT NOT LIMITED TO ITS CONDITION, QUALITY, PERFORMANCE, MERCHANTABILITY OR FITNESS FOR PURPOSE. Microchip disclaims all liability arising from this information and its use. Use of Microchip devices in life support and/or safety applications is entirely at the buyer’s risk, and the buyer agrees to defend, indemnify and hold harmless Microchip from any and all damages, claims, suits, or expenses resulting from such use. No licenses are conveyed, implicitly or otherwise, under any Microchip intellectual property rights unless otherwise stated.

Trademarks

The Microchip name and logo, the Microchip logo, AnyRate, dsPIC, FlashFlex, flexPWR, Heldo, JukeBlox, KeeLoq, KeeLoq logo, Kleer, LANCcheck, LINK MD, MediaLB, MOST, MOST logo, MPLAB, OptoLyzer, PIC, PICSTART, PIC32 logo, RightTouch, SpyNIC, SST, S ST Logo, SuperFlash and UNI/O are registered trademarks of Microchip Technology Incorporated in the U.S.A. and other countries.

ClockWorks, The Embedded Control Solutions Company, ETHERSYNCH, Hyper Speed Control, HyperLight Load, IntelliMOS, mTouch, Precision Edge, and QUIET-WIRE are registered trademarks of Microchip Technology Incorporated in the U.S.A.


SQTIP is a service mark of Microchip Technology Incorporated in the U.S.A.

Silicon Storage Technology is a registered trademark of Microchip Technology Inc. in other countries.

GestIC is a registered trademark of Microchip Technology Germany II GmbH & Co. KG, a subsidiary of Microchip Technology Inc., in other countries.

All other trademarks mentioned herein are property of their respective companies.


ISBN: 9781522410430

QUALITY MANAGEMENT SYSTEM CERTIFIED BY DNV

ISO/TS 16949

Microchip received ISO/TS-16949:2009 certification for its worldwide headquarters, design and wafer fabrication facilities in Chandler and Tempe, Arizona; Gresham, Oregon and design centers in California and India. The Company’s quality system processes and procedures are for its PIC® MCUs and dsPIC® DSCs, KeeLoq® code hopping devices, Serial EEPROMs, microperipherals, nonvolatile memory and analog products. In addition, Microchip’s quality system for the design and manufacture of development systems is ISO 9001:2000 certified.
Object of Declaration: MEC141x Family Device MECC Evaluation Board User's Guide

EU Declaration of Conformity

Manufacturer: Microchip Technology Inc.
2355 W. Chandler Blvd.
Chandler, Arizona, 85224-6199
USA

This declaration of conformity is issued by the manufacturer.

The development/evaluation tool is designed to be used for research and development in a laboratory environment. This development/evaluation tool is not a Finished Appliance, nor is it intended for incorporation into Finished Appliances that are made commercially available as single functional units to end users under EU EMC Directive 2004/108/EC and as supported by the European Commission’s Guide for the EMC Directive 2004/108/EC (8th February 2010).

This development/evaluation tool complies with EU RoHS2 Directive 2011/65/EU.

This development/evaluation tool, when incorporating wireless and radio-telecom functionality, is in compliance with the essential requirement and other relevant provisions of the R&TE Directive 1999/5/EC and the FCC rules as stated in the declaration of conformity provided in the module datasheet and the module product page available at www.microchip.com.

For information regarding the exclusive, limited warranties applicable to Microchip products, please see Microchip’s standard terms and conditions of sale, which are printed on our sales documentation and available at www.microchip.com.

Signed for and on behalf of Microchip Technology Inc. at Chandler, Arizona, USA

Derek Carlson  
VP Development Tools  

Date  
12-Sep-14
# Table of Contents

**Preface** ............................................................................................................................................. 7
  Introduction ........................................................................................................................................... 7
  Document Layout ................................................................................................................................. 7
**Audience** ........................................................................................................................................... 8
**Reference Documents** .......................................................................................................................... 8
**Glossary** .............................................................................................................................................. 8
**The Microchip Web Site** ...................................................................................................................... 9
Development Systems Customer Change Notification Service .............................................................. 9
**Customer Support** ............................................................................................................................... 10
Document Revision History ..................................................................................................................... 10

**Chapter 1. Overview**

1.1 Introduction ..................................................................................................................................... 11

1.2 Intel Platform Setup Requirements .................................................................................................... 12
  1.2.1 Hardware ................................................................................................................................. 12
  1.2.2 Software .................................................................................................................................... 12
  1.2.3 BIOS Support ........................................................................................................................... 12

1.3 Standalone Setup Requirements ........................................................................................................ 12
  1.3.1 Hardware ................................................................................................................................... 12
  1.3.2 Software ................................................................................................................................... 12

**Chapter 2. Evaluation Boards**

2.1 Features ............................................................................................................................................ 13
  2.1.1 MEC141x MECC Evaluation Board (ASSY. 6760A) ................................................................. 13

2.2 Hardware Setup ................................................................................................................................. 13
  2.2.1 Intel Skylake Y-Serial RVP ...................................................................................................... 13
  2.2.2 MEC141x MECC Evaluation Board (ASSY 6760A) ................................................................. 13

2.3 Software Setup .................................................................................................................................. 15
  2.3.1 Microsoft Windows 8.x on Intel Skylake Platform .................................................................... 15
  2.3.2 Microchip XPLABX IDE .......................................................................................................... 15
  2.3.3 Microchip XC32 PRO Compiler ............................................................................................... 15

2.4 Hardware Connection ........................................................................................................................ 16
  2.4.1 Intel Skylake Y-Serial RVP Connection .................................................................................... 16
  2.4.2 Standalone MEC141x MECC Card Connection ...................................................................... 17

2.5 MPLAB IDE Bring up .......................................................................................................................... 17

2.6 MPLAB IDE Dashboard ..................................................................................................................... 17

2.7 Project Clean and build ..................................................................................................................... 18

2.8 Build project for Debugging .............................................................................................................. 18
  2.8.1 Breakpoints ............................................................................................................................... 20
  2.8.2 Enter Debug Task ..................................................................................................................... 21
2.8.3 View Memory or CPU Register Information ...............................................22
2.8.4 View Variable .............................................................................................23
2.8.5 Exit Debug Task .........................................................................................23

2.9 BUILD PROJECT for SPI FLASH IMAGE .................................................... 23
2.9.1 Program SPI Image to MECC Board SPI Flash .........................................24

Appendix A. Intel Skylake Platform Rework Instructions
Worldwide Sales and Service .............................................................................29
Preface

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and documentation are constantly evolving to meet customer needs, so some actual dialogs and/or tool descriptions may differ from those in this document. Please refer to our web site (www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each page, in front of the page number. The numbering convention for the DS number is “DSXXXXX A”, where “XXXXX” is the document number and “A” is the revision level of the document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. Select the Help menu, and then Topics to open a list of available online help files.

INTRODUCTION

This chapter contains general information that will be useful to know before using the MEC141x family device MECC evaluation board. Items discussed in this chapter include:

- Document Layout
- Audience
- Reference Documents
- Glossary
- The Microchip Web Site
- Development Systems Customer Change Notification Service
- Customer Support
- Document Revision History

DOCUMENT LAYOUT

This document describes how to use the MEC141x family device MECC evaluation board (ASSY-6760 Rev. A) to mate with Intel’s latest generation reference board’s MECC connector or use as standalone development board. The User Guide layout is as follows:

- Chapter 1. “Overview” – An introduction and overview of the MEC141x MECC Board.
- Chapter 2. “Evaluation Boards” – Includes hardware setup information and demonstration procedures.
- Appendix A. “Intel Skylake Platform Rework Instructions” - Provides the rework steps for the Intel Skylake RVP motherboard, eSPI configuration with the MEC141x MECC Add-In Board.
AUDIENCE

This document is written for developers who are familiar with testing and design of Intel personal computer mobile systems, or generic embedded controller applications environment. The purpose of this document is to describe the functions and use of the MEC141x family device MECC evaluation board when connected to Intel’s latest generation reference validation platform (RVP) that supports the MECC connector to perform the appropriate drivers, BIOS, and components development and validation, or running standalone for other embedded controller applications.

REFERENCE DOCUMENTS

- MEC140x/1x Data Sheet, Rev. A
- MEC140x/1x eSPI Addendum, Rev. A
- ASSY. 6760A - MEC141x 128 VTQFP eSPI MECC Card, Rev. A1.0 Schematics
- MPLABX IDE Tools Documentation
- Intel eSPI Specification, June 2013, Revision 0.75 (Doc#: 327432-003)
- Intel Skylake Platform Design Guide, June 2014, Revision 0.9 (Doc#: 543016)
- Intel Skylake Ultrabook Platform Y-Series RVP3 CRB Schematic, March 2014, Revision 0.72 (Doc#: 544250)
- Intel Skylake Y EC AIC Enable Document for rework instructions to enable eSPI

GLOSSARY

This section describes glossary terms and acronyms used in this document.

<table>
<thead>
<tr>
<th>TERM</th>
<th>DEFINITION</th>
</tr>
</thead>
<tbody>
<tr>
<td>EVB</td>
<td>Evaluation Board</td>
</tr>
<tr>
<td>MECC</td>
<td>Modular Embedded Controller Card</td>
</tr>
<tr>
<td>ASSY.</td>
<td>Assembly Number Assigned to the Microchip EVB</td>
</tr>
<tr>
<td>ACPI</td>
<td>Advanced Configuration and Power Interface</td>
</tr>
<tr>
<td>BIOS</td>
<td>Basic Input/Output System</td>
</tr>
<tr>
<td>ASL</td>
<td>ACPI Source Language</td>
</tr>
<tr>
<td>EC</td>
<td>Embedded Controller</td>
</tr>
<tr>
<td>AIC</td>
<td>Add-In Card</td>
</tr>
<tr>
<td>LPC</td>
<td>Low Pin Count</td>
</tr>
<tr>
<td>eSPI</td>
<td>Enhanced Serial Peripheral Interface</td>
</tr>
</tbody>
</table>
THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web site is used as a means to make files and information easily available to customers. Accessible by using your favorite Internet browser, the web site contains the following information:

- **Product Support** – Data sheets and errata, application notes and sample programs, design resources, user’s guides and hardware support documents, latest software releases and archived software
- **General Technical Support** – Frequently Asked Questions (FAQs), technical support requests, online discussion groups, Microchip consultant program member listing
- **Business of Microchip** – Product selector and ordering guides, latest Microchip press releases, listing of seminars and events, listings of Microchip sales offices, distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip products. Subscribers will receive e-mail notification whenever there are changes, updates, revisions or errata related to a specified product family or development tool of interest.

To register, access the Microchip web site at www.microchip.com, click on Customer Change Notification and follow the registration instructions.

The Development Systems product group categories are:

- **Compilers** – The latest information on Microchip C compilers, assemblers, linkers and other language tools. These include all MPLAB C compilers; all MPLAB assemblers (including MPASM assembler); all MPLAB linkers (including MPLINK object linker); and all MPLAB librarians (including MPLIB object librarian).
- **Emulators** – The latest information on Microchip in-circuit emulators. This includes the MPLAB REAL ICE and MPLAB ICE 2000 in-circuit emulators.
- **In-Circuit Debuggers** – The latest information on the Microchip in-circuit debuggers. This includes MPLAB ICD 3 in-circuit debuggers and PICkit 3 debug express.
- **MPLAB IDE** – The latest information on Microchip MPLAB IDE, the Windows Integrated Development Environment for development systems tools. This list is focused on the MPLAB IDE, MPLAB IDE Project Manager, MPLAB Editor and MPLAB SIM simulator, as well as general editing and debugging features.
- **Programmers** – The latest information on Microchip programmers. These include production programmers such as MPLAB REAL ICE in-circuit emulator, MPLAB ICD 3 in-circuit debugger and MPLAB PM3 device programmers. Also included are nonproduction development programmers such as PICSTART Plus and PIC-kit 2 and 3.
CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative
• Local Sales Office
• Field Application Engineer (FAE)
• Technical Support

Customers should contact their distributor, representative or field application engineer (FAE) for support. Local sales offices are also available to help customers. A listing of sales offices and locations is included in the back of this document.

Technical support is available through the web site at:
http://www.microchip.com/support

DOCUMENT REVISION HISTORY

<table>
<thead>
<tr>
<th>Revision</th>
<th>Section/Figure/Entry</th>
<th>Correction</th>
</tr>
</thead>
<tbody>
<tr>
<td>DS50002312B (10-24-16)</td>
<td></td>
<td>Document Release</td>
</tr>
</tbody>
</table>
Chapter 1. Overview

1.1 INTRODUCTION

The MEC141x family device MECC evaluation board (ASSY 6760A) is mainly designed to be used with the Intel Skylake Y-Series RVP platform. The MECC board is a vehicle to support the development of BIOS, drivers, firmware, and so forth. This evaluation board can be also used as a standalone embedded controller development board for embedded and industrial computing applications.

The purpose of this document is to describe the functions of the MEC141x MECC eSPI Plug-In card as well as the setup procedures for full system development, to validate applications, or to power-up as standalone board for application development.

There are several on-board LPC devices on the Intel Skylake RVP platform. There is also an on-board MECC (AIC) connector to provide the capability for other vendors to develop and test their LPC/eSPI devices. The MEC141x family device MECC evaluation board is designed to plug into the MECC connector to demonstrate the operation of the MEC141x family devices on this platform. This user manual focuses on the Keyboard Controller and Embedded Controller functions available on the plug-in card.

FIGURE 1-1: MEC141X MECC CARD (ASSY 6760A) TOP & BOTTOM VIEWS
1.2 INTEL PLATFORM SETUP REQUIREMENTS

1.2.1 Hardware
- Intel Skylake Y-Series RVP Platform (with eSPI support)
- Microchip MEC141x family device MECC Card (ASSY 6760A)
- SPI Flash Programmer
  - Dediprog SF100 (http://www.dediprog.com/pd/spi-flash-solution/sf100)
- Skylake specific LCD Display or eDP support LCD Monitor
- 2.5” Notebook SATA HDD
- USB or PS/2 Keyboard & Mouse
- Optional - Microchip Pegasus Trace FIFO Debugger (Part#: PEGASUS-EVB)
- Optional - Select one of the Microchip Debugger Tools
  - PICKit3 (Part#: PG164130)
  - ICD3 (Part#: DV164035)
  - Real ICE (Part#: DV244005)
  - RJ11 to ICSP Adapter (Part#: AC164110) - Required for ICD3 or Real ICE

1.2.2 Software
- Microchip MPLABX IDE v2014-08-22 or later
- Microchip XC32 PRO Compiler v1.33 or later
- SPI Flash Programming Utility (ex: Dediprog utility)
- Microchip MEC141x SPI Flash Generator Utility
- Microchip MEC141x Firmware Sample Code

1.2.3 BIOS Support
Please contact Intel or your BIOS vendors if you need any BIOS related information or support.

1.3 STANDALONE SETUP REQUIREMENTS

1.3.1 Hardware
- Microchip MEC141x family device MECC Card (ASSY 6760A)
- External +3.3V Power Supply
- SPI Flash Programmer
  - Dediprog SF100 (http://www.dediprog.com/pd/spi-flash-solution/sf100)
- Optional - Microchip Pegasus Trace FIFO Debugger (Part#: PEGASUS-EVB)
- Optional - Select one of the Microchip Debugger Tools
  - PICKit3 (Part#: PG164130)
  - ICD3 (Part#: DV164035)
  - Real ICE (Part#: DV244005)
  - RJ11 to ICSP Adapter (Part#: AC164110) - Required for ICD3 or Real ICE

1.3.2 Software
- Microchip MPLABX IDE v2014-08-22 or later
- Microchip XC32 PRO Compiler v1.33 or later
- SPI Flash Programming Utility (ex: Dediprog utility)
- Microchip MEC141x SPI Flash Generator Utility
- Microchip MEC141x Firmware Sample Code
Chapter 2. Evaluation Boards

This chapter describes the MEC141x family device MECC card (ASSY 6760A) detailed information.

2.1 FEATURES

The MEC141x MECC Evaluation Board has the following components and features:

2.1.1 MEC141x MECC Evaluation Board (ASSY. 6760A)

- MEC141x Embedded Controller
- 32 KHz Crystal
- SPI Flash (W25Q128FV)
- UART Transceiver
- Power LED
- Connectors / Headers:
  - Intel MECC (AIC) Connector
  - eSPI Access Header
  - Powers Isolation Headers
  - SPI Flash Programming header (for Dediprog SF100 pin-out)
  - Two pins UART header
  - Unused GPIO headers
  - JTAG/ICSP debugger headers
  - Pegasus debugger header

2.2 HARDWARE SETUP

2.2.1 Intel Skylake Y-Serial RVP

- Plug-In LCD Display or Monitor
- Plug-In USB or PS/2 Keyboard and Mouse
- Plug-In USB DVD-ROM if required to install Windows
- Plug-In 2.5” SATA HDD
- Plug-In Skylake platform power adapter
- Press the power button to make sure the platform is boot-able to UEFI Shell or Windows 8.x

2.2.2 MEC141x MECC Evaluation Board (ASSY 6760A)

- Refer to Table 2-1 for jumper settings.
## TABLE 2-1: JUMPER SETTINGS ON MEC141X MECC BOARD (ASSY 6760A)

<table>
<thead>
<tr>
<th>Jumper</th>
<th>Function</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>JP1</td>
<td>VTR_33_18 Power Select</td>
<td>&lt;1-2&gt; for +1.8V&lt;br&gt;&lt;2-3&gt; for +3.3V (Default)</td>
</tr>
<tr>
<td>JP2</td>
<td>ADC_DAC_VREF to +3.3V</td>
<td>&lt;IN&gt; Connected (Default)&lt;br&gt;&lt;OUT&gt; Disconnected</td>
</tr>
<tr>
<td>JP4</td>
<td>PECI VREF_CPU power select</td>
<td>&lt;1-2&gt; Connect to Intel platform (Default)&lt;br&gt;&lt;2-3&gt; Connect to ground</td>
</tr>
<tr>
<td>JP5</td>
<td>VTR to +3.3V</td>
<td>&lt;IN&gt; Connected (Default)&lt;br&gt;&lt;OUT&gt; Disconnected</td>
</tr>
<tr>
<td>JP6</td>
<td>VBAT to +3.3V or Coin Battery</td>
<td>&lt;IN&gt; Connected (Default)&lt;br&gt;&lt;OUT&gt; Disconnected</td>
</tr>
<tr>
<td>JP7</td>
<td>TFDP or UART signals select</td>
<td>&lt;1-3 &amp; 2-4&gt; Connect to Pegasus TFDP header (Default)&lt;br&gt;&lt;3-5 &amp; 4-6&gt; Connect to UART header</td>
</tr>
<tr>
<td>JP8</td>
<td>+3.3V to V3.3V_EC_CORE</td>
<td>&lt;IN&gt; Connected (Default)&lt;br&gt;&lt;OUT&gt; Disconnected</td>
</tr>
<tr>
<td>JP9</td>
<td>nRESET_IN Group Option</td>
<td>&lt;IN&gt; Connected to ground (use for SPI flash program)&lt;br&gt;&lt;OUT&gt; Disconnected (Normal Operation)</td>
</tr>
<tr>
<td>JP10</td>
<td>System +3.3S to EC V3.3S power well</td>
<td>&lt;IN&gt; Connected (Default)&lt;br&gt;&lt;OUT&gt; Disconnected</td>
</tr>
<tr>
<td>JP11</td>
<td>System +3.3A_RTC to EC V3.3A_RTC power well</td>
<td>&lt;IN&gt; Connected (Default)&lt;br&gt;&lt;OUT&gt; Disconnected</td>
</tr>
<tr>
<td>JP13</td>
<td>System 1.8V_ESPI to EC RSVD_1.8V_ESPI power (Reserved for internal only)</td>
<td>&lt;IN&gt; Connected&lt;br&gt;&lt;OUT&gt; Disconnected (Default)</td>
</tr>
<tr>
<td>JP14</td>
<td>Grounded ICSP_MCLR</td>
<td>&lt;IN&gt; Grounded&lt;br&gt;&lt;OUT&gt; Not grounded (Default)</td>
</tr>
<tr>
<td>J1</td>
<td>Microchip ICSP Header</td>
<td>Connect to Microchip PICKit3 or ICD3 or Real ICE debugger</td>
</tr>
<tr>
<td>J2</td>
<td>SPI programming header</td>
<td>Connect to Dediprog SF100 SPI flash programmer</td>
</tr>
<tr>
<td>J3</td>
<td>Two pins UART header</td>
<td>Connect to UART (Null-modern) Cable</td>
</tr>
<tr>
<td>J4</td>
<td>Trace FIFO Debugger header</td>
<td>Connect to Microchip Pegasus board</td>
</tr>
<tr>
<td>J5</td>
<td>Ground the +5V Target Power</td>
<td>Not Used - Do Not Connect</td>
</tr>
<tr>
<td>J7</td>
<td>1x6 JTAG Header (Reserved for internal only)</td>
<td>Not Used - Do Not Connect</td>
</tr>
<tr>
<td>J8</td>
<td>eSPI Access Header</td>
<td>Not Used - Do Not Connect</td>
</tr>
<tr>
<td>J9</td>
<td>Unused GPIOs Header</td>
<td>Not Used - Do Not Connect</td>
</tr>
<tr>
<td>J10</td>
<td>Empty Header</td>
<td>Not Used - Do Not Connect</td>
</tr>
<tr>
<td>TP1</td>
<td>+V3.3A</td>
<td>Test Point for V3.3A power</td>
</tr>
<tr>
<td>TP2</td>
<td>EC_SPI_OE_N</td>
<td>Test Point for System EC_SPI_OE_N signal</td>
</tr>
<tr>
<td>TP4, TP5</td>
<td>Ground</td>
<td>Test Points to ground</td>
</tr>
<tr>
<td>TP6</td>
<td>VREF_ADC</td>
<td>Test Point for VREF_ADC power</td>
</tr>
</tbody>
</table>
2.3 SOFTWARE SETUP

2.3.1 Microsoft Windows 8.x on Intel SkyLake Platform

• Make sure the Intel Skylake platform is boot-able and able to complete the Microsoft Windows 8.x installation accordingly, and able to boot to the Windows 8.x.
• Please contact your Intel representative if you need any further assistance.

2.3.2 Microchip XPLABX IDE

• Install the beta version 2014-08-22 or later.
• Double click on the installation file, MPLABX-v2014-08-22-windows-installer.exe under the developer’s windows machine.
• Follow the instructions to complete the installation.
• Please contact your Microchip representative if you need any further assistance.

2.3.3 Microchip XC32 PRO Compiler

• Install the beta version 1.33 (that supports the MEC141x family devices) or later.
• Double click on the installation file, xc32-v1.33-full-install-windows-installer.exe under the developer’s windows machine after installing the MPLABX.
• Follow the instructions to complete the installation.
• At the end of installation, please follow the instruction to activate the XC32 PRO license key.
  - User can use xclm.exe in the compiler directory (ex: C:\Program Files (x86)\Microchip\xc32\v1.33\bin) to check the status by “xclm -status” command.
• Please contact your Microchip representative if you need any further assistance.
2.4 HARDWARE CONNECTION

2.4.1 Intel Skylake Y-Serial RVP Connection

This section shows the hardware connection between Intel Skylake RVP platform and the Microchip MEC141x family device MECC evaluation board along with other components.

1. Connect Microchip Real ICE to the MECC J1 with RJ-11 to ICSP adapter
2. Connect Pegasus Trace Debugger to the MECC J4 – for trace debugging
3. Connect Dediprog SF100 to J2 for SPI flash programming
2.4.2 Standalone MEC141x MECC Card Connection

In the standalone setup, on top of steps 1 to 3 as described above for debug and development tools connections, we need to connect the power from external +3.3V power source since we don’t have the sources from Intel platform.

4. Connect MEC141x MECC Card JP8 Pin 1 (3.3_EC_CORE) to an external +3.3V power supply.

5. Connect a solid good ground source from the same power supply to the MEC141x MECC Card ground pin such as TP38 Pin 2, or TP4, or TP5, etc.

2.5 MPLAB IDE BRING UP

1. Launch the IDE - from Start → All Programs → Microchip → MPLAB X IDE →

2. Open Existing project – MPLabx IDE → File → Open Project, Navigate the browser to the project setting files which have the project name with .X extension. Right Click on project name and set Project as main project.

2.6 MPLAB IDE DASHBOARD

MPLABX IDE → Window → DashBoard will give details of the project for:

1. Compiler Toolchain
2. Memory Used
3. Debug tool
4. Debug resources
2.7 PROJECT CLEAN AND BUILD

To compile the project, right click on project name and choose either “Build”, “Clean and Build”, or “Clean” option. From Menu bar MPLABX IDE → Run → Build Main Project / Clean and Build.

2.8 BUILD PROJECT FOR DEBUGGING

To debug the project with Real ICE, make sure the connection is correct and the proper Drivers are installed for the Debugger:

From the Menu Bar select Debug Main Project or

From MPLABX IDE → Debug Main Project
Project will be rebuilt with debug option.

A successful build, if Real Ice is connected, will establish the connection and download the code to the target board for debugging.
2.8.1 Breakpoints

Breakpoints can be set before launching the debug option or while target device is halted. From Dashboard menu we can see the breakpoints available / used. Set the break point as required – the break points can be viewed from Menu bar → Windows → Debugging → Breakpoints or short cut key Alt + Shift + 5.
Previously set Break points can be enabled or disabled using the select option.

2.8.2 Enter Debug Task

Select Debug Project (project name xxx) from Menu Bar, IDE will connect ICE and project code into chip, then initiate to execute the code, code will be halted at the breakpoint which use previous settings.
User can debug code via “step over”, “step into” or “continue”.

2.8.3 View Memory or CPU Register Information

As user hits “Pause” to halt code execution, and select “Windows > PIC memory view > CPU registers”, the registers windows will be shown as:

User can view other memory information, e.g. Data or code memory etc.
2.8.4 View Variable

For viewing or examining variables Menu bar → Windows → Debugging Variables or short cut Alt+ Shift + 1.

![Image of Debugging Variables menu]

2.8.5 Exit Debug Task

Select “Finish debugger session”, IDE will terminate debugging task, and return to editor windows.

![Image of Finish debugger session]

2.9 BUILD PROJECT FOR SPI FLASH IMAGE

Please refer to the MEC1418 Firmware Example Code Readme.txt for more detailed information.

Steps are shown as below:

1. Extract firmware binary from XC32 ELF output (refer to Section 2.7 “Project Clean and build”). Use XC32 OBJCOPY utility,

```
xc32-obcopy -O binary <ELF-File-Name> <Binary-File-Name>
```

2. Make sure TOML configuration file (ex: spi16M_cfg.toml) has the proper values for the firmware binary.
   - If you are loading into the start of MEC1418 Code SRAM then use 0xBF-CF0000 for Load Address.
   - With the example projects linker file, the _reset entry point is also at 0xBF-CF0000 and use this value for Entry Point Address.
3. Run the SPI generator,

```
mecl4xx_spi_gen -p MEC1418 -i <TOML file name> -o <output binary file name>
```

### 2.9.1 Program SPI Image to MECC Board SPI Flash

Now, we should have a SPI firmware image (16MB binary) from the build process as described above. Do the following to program the SPI image to the MECC board external SPI Flash image:

1. The MEC141x MECC Board has onboard 3V 128M-bit (16MB) SPI Flash (part#: Winbond W25Q128FV). If this is being replaced, please follow the example code then rebuild the binary with correct configuration.
2. Connect the Dediprog SF100 (or SF600) to the MEC141x MECC Board J2 header.
3. Plug-In a jumper to JP9 to hold the MEC141x in RESET state.
4. Plug-In the MEC141x MECC Board to the Intel Skylake RVP Platform or jumper wire JP8 Pin 1 (3.3_EC_CORE) to an external +3.3V power supply & ground pins (more is better) from MECC Board to power source.
5. Turn on the Intel Skylake RVP Platform or the external +3.3V power supply.
6. Run the Dediprog programming utility, “dedipro.exe”, the chip selection window will pop-up as shown below, please select the "W25Q128FV".

![Memory Type Ambiguity](image.png)
7. The Info sessions on the right side should be shown as below:

![Windows System Info](image)

8. Go to “File” --> “Find” and select the 16MB firmware application binary file, set the data format as “Raw binary” as shown below:

![Load File](image)
9. Go to “Config” --> “Flash Option”, make sure “Unprotect block automatically when block(s) protected” option is selected.
10. Click to the “Batch”, the SPI flash programming will start, and should complete successfully as shown below.

11. The firmware is now stored in the external SPI flash device. Please remove the JP9, and do a power cycle (please make sure to wait long enough to have power supply discharge before re-powering the MECC board). The new firmware should be loaded by the MEC141x internal ROM to the internal SRAM and start executing.

Please contact your Microchip representative if you need any further information or assistance.
Appendix A. Intel Skylake Platform Rework Instructions

This section provides the rework steps for the Intel Skylake RVP motherboard, eSPI configuration with the MEC141x MECC Add-In Board.


<table>
<thead>
<tr>
<th>Intel Step Nos.</th>
<th>Parts</th>
<th>See Silkscreen Sheet #</th>
<th>Rework Action</th>
<th>Component: Value / Form / Tolerance</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1, 2, 3</td>
<td>none</td>
<td>(n/a)</td>
<td>(None)</td>
<td>(n/a)</td>
<td>(Jumper settings only: Open J2B5, J2E1; Close J2B7.)</td>
</tr>
<tr>
<td>4, 5</td>
<td>R4D12</td>
<td>B2 or B3</td>
<td>Move resistor to position R4D11.</td>
<td>22-ohm / 402 / 5%</td>
<td>3 pads at right angles: Rotate the resistor to the other orientation.</td>
</tr>
<tr>
<td>6, 7</td>
<td>R3D17</td>
<td>B2 or B3</td>
<td>Move resistor to position R3D16.</td>
<td>0-ohm / 402</td>
<td>3 pads in a line. Shift resistor to other position.</td>
</tr>
<tr>
<td>8, 9</td>
<td>R5E23</td>
<td>C2</td>
<td>Move resistor to position R5E22</td>
<td>0.05-ohm / 603 / 1%</td>
<td>3 pads in a line. Shift resistor to other position.</td>
</tr>
<tr>
<td>10</td>
<td>R8F35</td>
<td>C1</td>
<td>Replace 150K resistor w/ 4.7K resistor.</td>
<td>(FYI was 150K / 402 / 5%) now 4.7K / 402 / 5%</td>
<td>New 4.7K resistor needed, not supplied.</td>
</tr>
<tr>
<td>11</td>
<td>R4E24, R4E6, R4E13, R4E12, R4E5, R3D32</td>
<td>B2</td>
<td>Remove resistors.</td>
<td>(FYI 0-ohm / 402)</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>R4D17, R4D15, R4D18, R4D16, R4D19, R4D13</td>
<td>B3</td>
<td>Remove resistors.</td>
<td>(FYI 0-ohm / 402)</td>
<td></td>
</tr>
<tr>
<td>13, 14</td>
<td>(n/a)</td>
<td>(n/a)</td>
<td>(None)</td>
<td>(n/a)</td>
<td>Rework not required</td>
</tr>
<tr>
<td>14a (new)</td>
<td>R3E2</td>
<td>B3</td>
<td>Remove resistor.</td>
<td>(FYI - 10K / 402 / 5%)</td>
<td>Rework required</td>
</tr>
<tr>
<td>15</td>
<td>R5E65, R4E4, R2N11</td>
<td>C2, B2 Underside</td>
<td>Remove resistors.</td>
<td>(FYI - 10K / 402 / 5%)</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>R5F30</td>
<td>C2</td>
<td>Remove resistor.</td>
<td>(FYI - 8.2K / 402 / 5%)</td>
<td></td>
</tr>
</tbody>
</table>

Note: Highlighted items differ from Intel’s instructions.
<table>
<thead>
<tr>
<th>AMERICAS</th>
<th>ASIA/PACIFIC</th>
<th>ASIA/PACIFIC</th>
<th>EUROPE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Corporate Office</td>
<td>Asia Pacific Office</td>
<td>China - Xiamen</td>
<td>Austria - Wels</td>
</tr>
<tr>
<td>2355 West Chandler Blvd.</td>
<td>Suites 3707-14, 37th Floor Tower</td>
<td>Tel: 86-592-2388138</td>
<td>Tel: 43-7242-2244-39</td>
</tr>
<tr>
<td>Chandler, AZ 85224-6199</td>
<td>6, The Gateway Harbour City, Kowloon</td>
<td>Fax: 86-592-2388130</td>
<td>Fax: 43-7242-2244-393</td>
</tr>
<tr>
<td>Tel: 480-792-7200</td>
<td>Hong Kong</td>
<td>China - Zhuhai</td>
<td>Denmark - Copenhagen</td>
</tr>
<tr>
<td>Fax: 480-792-7277</td>
<td>Tel: 852-2943-5100</td>
<td>Tel: 86-756-3210040</td>
<td>Tel: 45-4450-2828</td>
</tr>
<tr>
<td>Technical Support:</td>
<td>Fax: 852-2401-3431</td>
<td>Fax: 86-756-3210049</td>
<td>Fax: 45-4485-2829</td>
</tr>
<tr>
<td><a href="http://www.microchip.com/">http://www.microchip.com/</a></td>
<td></td>
<td></td>
<td>Finland - Espoo</td>
</tr>
<tr>
<td>support</td>
<td></td>
<td></td>
<td>Tel: 358-9-4520-820</td>
</tr>
<tr>
<td>Web Address:</td>
<td></td>
<td></td>
<td>France - Paris</td>
</tr>
<tr>
<td><a href="http://www.microchip.com">www.microchip.com</a></td>
<td></td>
<td></td>
<td>Tel: 33-1-69-53-63-20</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Fax: 33-1-69-30-90-79</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>France - Saint Cloud</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Tel: 33-1-30-60-70-00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Germany - Garching</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Tel: 49-8931-9700</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Germany - Haan</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Tel: 49-2129-3766400</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Germany - Heilbronn</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Tel: 49-7131-67-3636</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Germany - Karlsruhe</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Tel: 49-721-625370</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Germany - Munich</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Tel: 49-89-627-144-0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Fax: 49-89-627-144-44</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Germany - Rosenheim</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Tel: 49-8031-354-560</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Israel - Ra'anana</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Tel: 972-9-744-7705</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Italy - Milan</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Tel: 39-0331-742611</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Fax: 39-0331-466781</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Italy - Padova</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Tel: 39-049-7625286</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Netherlands - Drunen</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Tel: 31-416-690399</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Fax: 31-416-690340</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Norway - Trondheim</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Tel: 47-7289-7561</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Poland - Warsaw</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Tel: 48-22-3325737</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Romania - Bucharest</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Tel: 40-21-407-87-50</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Spain - Madrid</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Tel: 34-91-708-08-90</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Fax: 34-91-708-08-91</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Sweden - Gothenberg</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Tel: 46-31-704-60-40</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Sweden - Stockholm</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Tel: 46-8-5090-4654</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>UK - Wokingham</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Tel: 44-118-921-5800</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Fax: 44-118-921-5820</td>
</tr>
</tbody>
</table>